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Abstract: In the last decades, the increase in global industrialization and the consequent technological
progress have damaged the quality of the environment. As a consequence, the high levels of hazardous
compounds such as metals and gases released in the atmosphere and water, have raised several
concerns about the health of living organisms. Today, many analytical techniques are available with the
aim to detect pollutant chemical species. However, a lot of them are not affordable due to the expensive
instrumentations, time-consuming processes and high reagents volumes. Last but not least, their use is
exclusive to trained operators. Contrarily, colorimetric sensing devices, including paper-based devices,
are easy to use, providing results in a short time, without particular specializations to interpret the
results. In addition, the colorimetric response is suitable for fast detection, especially in resource-limited
environments or underdeveloped countries. Among different chemical species, transition and heavy
metals such as iron Fe(II) and copper Cu(II) as well as volatile compounds, such as ammonia (NH3)
and acetaldehyde (C2H4O) are widespread mainly in industrialized geographical areas. In this work,
we developed a colorimetric paper-based analytical device (PAD) to detect different contaminants,
including Fe2+ and Cu2+ ions in water, and NH3 and C2H4O in air at low concentrations. This study
is a “proof of concept” of a new paper sensor in which the intensity of the colorimetric response
is proportional to the concentration of a detected pollutant species. The sensor model could be
further implemented in other technologies, such as drones, individual protection devices or wearable
apparatus to monitor the exposure to toxic species in both indoor and outdoor environments.
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1. Introduction

In the last decades, due to the increase of industrialization activities, the release of hazardous
materials in the atmosphere, water and soil has raised many concerns about their impact on living
organisms [1]. Metals and heavy metals together with gaseous organic compounds are the most
widespread toxic elements due to their ability to enter the living organism by different routes, such as
inhalation and ingestion [2,3]. Then, they can enter the food chain, integrating into enzymatic processes
with the consequence to boost various diseases and inflammation processes onset [4].

Cu(II) and Fe(II) are transition metals having a key role in several physiological pathways, such as
fetal growth, brain development, cholesterol metabolism and immune function [5–7]. Cu(II) represents
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one of the main components of the PM 2.5 produced by the road dust emissions, allowing its easy
penetration into the organisms’ body [8].

In addition, the ecological risk deriving from Cu(II) exposure is a problem in European saltwater
environments [9,10]. Cu(II) can be toxic to aquatic life at concentrations approximately 10 to 50 times
higher than the tolerated range [11]. In addition, humans can adsorb a great amount of Cu(II) from
drinking water, food, air and supplements, reaching a daily absorption of 1.85 mg [12]. In order to
understand the collateral effects of the Cu(II), the US National Toxicology Program (NTP) exposed
B6C3F1 mice to the five concentrations of Cu(II) (76, 254, 762, 2543, 7629 mg Cu/L) to [13] for 13 weeks
observing the organs weight loss and animals death, at the higher concentrations tested. These results
were consistent with another study in which the same toxicity was observed in female and male
mice using 762 mg/L of Cu(II). Additionally, Fe(II) triggered adverse effects in vivo by acute toxicity
induction [14]. In aquatic environments, Fe(II) boosted the growth default of aquatic organisms at a
concentration of 1 mg/L [15]. In addition, in some European countries such as Lithuania, people were
exposed to high levels of Fe(II) due to the contamination of groundwater that overcome the permissible
limit established by the European Union Directive 98/83/EC, related to the quality of drinking water [16].
Regarding the volatile compounds pollution, NH3 is one of the major manufactured industrialized
soluble alkaline gases on Earth [17]. NH3 originates from both natural and anthropogenic sources,
in particular from the agricultural industry, high-density intensive farming practices as well as fertilizer
applications [18]. According to the Agency for Toxic Substances and Disease Registry, the concentrations
of NH3 in the environment are very variable due to its continuous recycling and its internalization in
biosphere. Therefore, it is possible to find different natural NH3 levels in the soil (1–5 ppm), in air
(1–5 ppb) and in water (approximately 6 ppm) [19]. The NH3 smell can be identified by humans at
concentrations greater than 5 ppm; at 30 ppm and with an exposure time of up to 2 h, human volunteers
underwent slight irritation, whereas strong effects were recorded up to 500 ppm [20]. However,
NH3 lethality requires higher concentrations [21]. In addition to NH3, also some kinds of carbonyls
which constitute the motor vehicle exhaust, such as C2H4O are toxic air contaminants, particularly
dangerous for living organisms [22,23]. Woutersen et al. [24] used Wistar rats to study the toxic effect
of C2H4O administered in air (6 h/day) at three concentrations (750, 1.500, 3.000 ppm) for more than a
year. All the concentrations tested induced the increase of nasal tumors incidence with remarkable
impact especially at higher concentrations. Other evidences suggested that the C2H4O administration
(1.650–2.500 ppm) for more than two years (7 h/day) induced tracheal, but not nasal, tumors in Syrian
golden hamsters [25]. Then, the study of these compounds in polluted areas is a key factor to control
the exposure rate.

Today, several analytical techniques are available for the detection of toxic analytes. However,
many of them are not affordable due to the expensive instrumentations and high reagent volumes
required. On the contrary, point-of-care and easy-to-use analysis provide results in a short time,
preventing the production of an elevated amount of waste [26]. In addition, they can be employed in
resource-limited environments and developing countries where pollution is uncontrollable and not
regulated with specific rules.

In particular, paper is the best choice to develop sustainable devices [27]; it is considered a
valid alternative to traditional materials due to its ease of fabrication, satisfactory levels of sensitivity,
specificity, low cost, lightweight, versatility, being easily portable and low reagent consumption
requiring [28,29]. The paper-based analytical devices (PAD) can work following the principle of
color change in the presence of specific target analytes [30]. The sensitivity and specificity of
the assay are dependent on an interaction between the target analyte and the surface of the PAD
due to the functionalization of cellulose fibers [31]. The paper surface can be functionalized by
different molecules, such as chemoresponsive dyes, nanoparticles (NPs) and biomolecules (antibodies,
aptamers, nucleic acids) [32–35]. Xi et al. [36] prepared a paper device based on Pb(II) metal-organic
nanotubes characterized by a large {Pb14} metallamacrocycle, to detect H2S based on the fluorescence
“turn-off” response. However, the fabrication of nanotubes and the general technique required specific
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scientific competences and elevated costs; moreover the toxicity of nanotubes, is not negligible [37].
Maity et al. [38] used perovskite halide (CH3NH3PbI3) to achieve a thin-film sensor fabricated on a
paper by a growth process able to detect NH3 gas by a color change from black to yellow. Despite the
effectiveness of this device, the H3NH3PbI3 is chemically unstable and toxic for living organisms. [39].
Then, the disposal of the device could present a serious problem. In a recent work [40], a microporous
cellulose-based smart xerogel bromocresol purple was used into cross-linked carboxymethyl cellulose
to detect NH3 by a colorimetric response. The authors performed a freeze-drying process to obtain the
xerogel with a low limit of detection.

In these PADs, the colorimetric shift can be evaluated by colorimetric assay, as a result of the
interaction with the ligand. In general, the PADs sensing areas are fabricated by the printing method
using a wax printer [41]. The results obtained can be directly interpreted by the naked eye together
with the spectrophotometer analysis. In the last years, the use of smartphones to detect color change
has been developed [42–44]. Therefore, its use showed some limitations regarding the low lighting
conditions that prevent the smartphone camera exploitation [44].

In this work, we developed an effective PAD suitable to detect different contaminants, namely Fe(II)
and Cu(II) cations (Fe2+ and Cu2+) in water and NH3 and C2H4O vapor in air. The design and fabrication
of the sensor did not require specific instrumentations. In particular, for metals detection, only a
wax pen able to design the specific areas of chemical interaction was required, without the use of a
wax printer. We functionalized the paper (Whatman filter paper) using different analytes capable
of reacting with metallic ions and gaseous substances, allowing a specific response; the aim of this
process was to develop calibration curves to correlate the obtained color to the concentrations of
toxic compounds. The results were easily interpreted using a digital scanner and ImageJ. The tests
achieved using intermediate concentrations suggested the sensitivity and reproducibility of the PAD,
making it a powerful tool to detect hazardous materials in different mediums without the use of
sophisticated technologies.

2. Materials and Methods

2.1. Ammonia Detection

2.1.1. Reagents

Whatman filter paper n.1 (thickness 180 µm), ammonium hydroxide (NH4OH, 28%), hydrochloric
acid (HCl), Aniline (C6H5NH2) and ammonium persulfate (NH4)2S2O8 were purchased from Merck.

2.1.2. Functionalization of Whatman Paper for Reversible Ammonia Vapor Detection

The reversible colorimetric detection of gaseous NH3 was realized by coating Whatman filter
paper with polyaniline (PANI) film, achieved by C6H5NH2 polymerization (2.5 g/L) in the presence of
HCl (1 M) and (NH4)2S2O8 (0.125 g/L) at room temperature [45]. Briefly, (NH4)2S2O8 solution was
added dropwise into the C6H5NH2 solution under stirring (1000 rpm). The two compounds were in a
volume ratio of 1:1. After 3 min, half of the colorless reaction mixture was immediately added into a
silicon funnel, where a piece of round filter paper (c.a 2 cm) was placed and fixed. Then, the remaining
solution was slowly suction-filtered through the filter paper, and the unused volume was left in the
dark for approximately 1 h. During this time, the solution slowly turned light blue. After this step,
the solution was again filtered and then, the paper was carefully washed with Milli-Q water. Finally,
it was left to air dry until the emerald green filter paper was achieved. The functionalized paper
was exposed to different concentrations of NH3. The schematic representation of this procedure is
represented in Figure 1a.
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Figure 1. Schematic NH3 (a) and C2H4O (b) paper sensor fabrication procedure: (a) 1. Half of the
colorless reaction mixture was immediately suction-filtered into a silicon funnel where a filter paper
(white circle) was placed. 2. The remaining part of the solution was left to stand for 1 h. During this
time, the solution turned light blue. 3. The solution was filtered (II suction-filtration) through the
filter paper, in order to induce the polyaniline (PANI) deposition. After several washes and air flow
drying, the formation of emerald green filter paper (green circle) was completed. 4. The emeraldine
green filter paper turned into a blue emeraldine base (blue circle) as a result of NH3 vapor exposure.
(b) 1. The methyl red and methyl red sodium Salt were added to the mixture. The color solution turned
into red-orange and was stirred for 1 h. After this time, NaOH was added, resulting in a color change
to yellow. The solution was left to stand for 1 h. 2. The solution was transferred in a petri dish and
the filter paper was immersed in it for 1 h. The filter paper was dried overnight in the dark at room
temperature. The formation of methyl red filter paper (yellow circle) was completed. 3. The methyl red
filter paper turned into red (red circle) as a result of C2H4O vapor exposure.

2.1.3. Construction of Calibration Curve by Colorimetric Response to Ammonia Vapor

Glass vials were used to detect NH3 vapor exposure. In each vial, 10 mL of NH3 solution
was added at different concentrations (100, 300 500 and 1000 ppm) to achieve a standard curve.
Small PANI-deposited filter paper pieces were fixed on the necks of the vials in order to expose them
to the vapor generated from the corresponding NH3 aqueous solution for a few seconds. The control
was represented by pure NH3. After this time, the paper was immediately removed and analyzed by a
scanner (Samsung SCX-3400 series (USB002)) acquiring the color change after NH3 vapor interaction.
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2.2. Acetaldehyde Detection

2.2.1. Reagents

Whatman Filter paper n.1 (thickness 180 µm), methyl red (C15H15N3O2), methyl red sodium
salt (C15H14N3NaO2), methanol (CH3OH), Glycerol (C3H8O3) and sodium hydroxide (NaOH) were
purchased from Merck.

2.2.2. Functionalization of Whatman Paper for Acetaldehyde Vapor Detection

The colorimetric detection of gaseous C2H4O was obtained by coating a Whatman filter paper
with thin methyl red film. methyl red and methyl red sodium salt was dissolved in a solvent constituted
by CH3OH, water and C3H8O3 (1 mM). The red-orange solution was stirred for approximately 1 h.
NaOH (8 mM) was added to the solution and stirred at room temperature for 1 h. The yellow-colored
solution obtained was translocated in a petri dish where a piece of Whatman filter paper was immersed
for 1 h. After this time, the paper was dried at room temperature overnight. The filter paper sheet was
then cut into small round disks (diameter of approximately 2 cm) and successively exposed to different
concentrations of C2H4O. After 5 min, the color appeared on the paper. The schematic representation
of this procedure is represented in Figure 1b.

2.2.3. Construction of Calibration Curve by Colorimetric Response to Acetaldehyde Vapor

The C2H4O vapor detection was performed using different glass vials in which 10 mL of C2H4O
was added at different concentrations in CH3OH solvent: 100, 300, 500 and 1000 ppm, respectively,
on the vial’s neck. The deposited filter paper pieces were fixed in order to expose them to the vapor
evaporated from each C2H4O/CH3OH solution for 5 min. After this time, the paper was immediately
removed and analyzed by a scanner (Samsung SCX-3400 series (USB002)) in order to acquire the color
changes after C2H4O interaction.

2.3. Fabrication of Paper-Based Colorimetric Device for Fe2+ and Cu2+

2.3.1. Reagents

Iron chloride tetrahydrate (FeCl2·4H2O), HCl, copper sulfate pentahydrate (CuSO4·5H2O),
potassium ferricyanide (K3[Fe(CN)6]), and potassium iodide (KI) were purchased from Merck.

2.3.2. Iron and Copper Calibration Curve Standard Solutions Preparation

FeCl2·4H2O was dissolved in HCl (0.5 M) in order to achieve 1000 µg/mL of Fe2+ standard stock
solution whereas CuSO4·5H2O was used to prepare 1000 µg/mL Cu2+ standard stock solution in Milli-Q
water. The series of four standard solutions (25, 50, 100 and 200 µg/mL) of Fe2+ and Cu2+ were prepared
by diluting the standard stock solutions with different volumes of Milli-Q water. After these steps,
K3[Fe(CN)6] (5 mM) and KI (0.4 M) solutions were prepared for Fe2+ and Cu2+ detection, respectively.

2.3.3. Fabrication of the Paper Analytical Device (PAD)

The fabrication of PAD was developed as follows:

1. The waxy channels on a piece of Whatman filter paper were obtained by using a wax pen.
The shape of each channel was circular with a diameter of approximately 0.5 cm. Four spots were
drawn on the filter paper, one for each standard.

2. The PAD was heated on a hot plate at ~60 ◦C for 1 h to melt the wax. The liquid wax penetrated
into the cellulose pores to achieve hydrophobic barriers.

3. The PAD was dried at room temperature for approximately 30 min.
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2.3.4. Assay Procedure

A small volume (5 µL) of Fe2+ and Cu2+ assay reagents ((K3[Fe(CN)6]) and KI) was spotted by
drop-casting on paper circular dots using a micropipette and allowed to dry at the room temperature
for 3 h. Five microliters of each standard solution was added to the corresponding labeled spots of
the PAD. The Fe2+ of the standard solutions reacted with the K3[Fe(CN)6] generating blue colored
complex in the detection zones. Instead, the Cu2+, reacting with KI, produced a red-brown compound.
The intensity of the color was proportional to the standard solution concentration. A schematic
representation of the described process was represented in Figure 2.Sensors 2020, 20, x FOR PROOF 6 of 18 
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Figure 2. Schematic Fe2+ and Cu2+ colorimetric assay procedure: (a) The four spots were achieved
by wax pen in order to create hydrophobic barriers after heating using a hot plate. (b,c) Five microliters
of each standard solution were added by drop-casting to the corresponding labeled spot. (d) On the
Fe(II) paper-based analytical device (PAD), a blue complex was formed after the reaction between
the Fe2+ and ((K3[Fe(CN)6]); the blue color intensity directly correlated with the Fe2+ concentration
(e) On the Cu(II) PAD a red-brown compound was developed, generating by Cu2+ and KI reaction,
whose color intensity was dependent on Cu2+ concentration.

2.4. Quantitative Image Processing by ImageJ 1.47 Software

Once the color changes were achieved due to the chemical interaction with the different hazardous
compounds, the corresponding PADs images were captured using scanner Samsung SCX-3400 with
a resolution of 300 dpi. Then, the images were stored in JPEG format and analyzed in RGB format
with the open-source software, ImageJ [46]. An adjustment of the color threshold was applied to each
image to filter out all colors that were not correlated to the colored complex to be detected during the
analysis. For instance, the Fe2+ color adjustment was applied to delete all colors which was not in the
blue range from the analysis spectrum. The color adjustment was set as follows:

1. The “Color Threshold” window was accessed through the ImageJ menu by selecting “Image”→
“Adjust”→“Color Threshold.”

2. At the bottom of this window HSB was selected, which allowed the adjustment of hue, saturation,
and brightness.
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3. The hue was adjusted by moving the sliders directly below the “Hue” spectrum until only the
color of interest was visible. The hue threshold ranges set for each metal were fixed as follows:
NH3 (244–255), C2H4O (38–240), Fe2+ (171–197), Cu2+ (37–255).

The images were then converted to an 8-bit grayscale (“Image” → “Type” → “8-bit”) and
inverted (“Edit” → “Invert”). The intensity measurements yielded a positive slope when plotted
versus metal amounts. Mean Gray Value (MGV) was measured for each RGB channel (red, blue and
green, “Image”→ “Color”→ “Merge Channel”) by first selecting “mean gray value” and “limit to
threshold” in the “Set measurements window,” found from the ImageJ menu by selecting “Analyze”
→ “Set measurements”. Each area was selected using the wand tool, which automatically found
the edge of an object and traced its shape. The gray intensity of the outlined area was measured by
selecting “Analyze”→ “Measure.” Then, the RGB channel was selected with the highest sensitivity for
the metal detection according to Yu et al. [47]. The blue channel was selected for both metal cations¸
the red channel for NH3 and green channel for C2H4O were selected. Data were then imported into
Microsoft Excel 2019 in order to obtain the different calibration curves for the NH3, C2H4O, Fe2+,
Cu2+ concentrations.

The colorimetric detection limits of NH3, C2H4O, Fe2+ and Cu2+ were estimated based on 3SB/S
according to IUPAC rules, where SB and S are standard deviation and slope, respectively [48,49].

2.5. Interference Studies

The selectivity of PAD to Cu2+ and Fe2+ was evaluated by interferences assessment exposing
the functionalized PAD to several metal ions solutions containing Na+, K+, Mg2+, Ca2+, Al3+, Mn2+,
Fe3+, Co2+, Ni2+, Zn2+, Cd2+ and Pb2+ at a concentration of 100 µg/mL. The same procedure was used
to assess the specificity of PAD to NH3 and C2H4O using methylamine, ethylamine, triethylamine,
benzene, toluene, ethyl benzene, formaldehyde and ethanol at a concentration of 500 ppm.

3. Results and Discussion

In recent years, the environmental pollution has been at the center of many debates, due to the
progressive and intense industrialization; the scientific community has thus focused its attention on the
potentially toxic effects of certain substances on the living organisms [50]. Several people are exposed
to different kinds of substances owing to the contamination of several environments in particular
water, atmosphere and soil [51]. Among these, the most widespread are certainly the transition
metals, heavy metals and gaseous substances, that are produced by intense processing activities
especially in the agrifood sector [52]. These chemicals are generally released into the atmosphere and
they can reach the groundwater as well as lakes and sea reaching living organisms with subsequent
collateral effects [3,53]. In this scenario, environmental monitoring is a fundamental objective to prevent
and to know at what doses an organism was exposed. The conventional analytical techniques (gas
chromatography–mass spectrometry, high-performance liquid chromatography–mass spectrometry,
atomic absorption spectroscopy) are sophisticated systems that require high energy consumption
and expensive laboratory systems. Paradoxically, in fact, the environment analysis by the use of
these instruments induces in turn pollution (energy, consumables, toxic reagents). Starting from these
assumptions, we have developed a PAD that can be used without the need for trained operators to
monitor some hazardous materials such as NH3, C2H4O, Fe2+ and Cu2+. For gaseous substances,
namely NH3 and C2H4O, we performed two different techniques to functionalize the filter paper.
In particular, for NH3 detection, we used a PANI film functionalization following the polymerization
of aniline directly on paper substrate. The PANI film obtained was in the form of green emeraldine salt
due to the protonation of the backbone induced by HCl. We selected four doses of NH3 on the basis of
toxicological results obtained in literature, as reported in the Introduction section (Section 1). When NH3

molecules reached the functionalized paper, the deprotonation of PANI chains and, consequently,
the transformation of them into a blue emeraldine base occurred. In addition, this dye shows peculiar
chemical properties consisting of the reversible doping/dedoping nature. The dye reacted with the
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NH3 determining the color change; when the analyte was removed, it can be reverted to its initial
chemical state. Due to the reversible nature of the process, the functionalized PAD can be reused many
times (ca. 30 times) before its discard. After the exposure to different concentrations of NH3 vapor
(100, 300, 500, 1000 ppm) the color appeared in a few minutes. Immediately, a digital scanner was
used to freeze the specific color. The scanner acquired the image in JPEG format, allowing the next
analysis by ImageJ software. As shown in Figure 3, the paper assumed a specific coloration that can be
visualized with the naked eye. The color switch from light green to blue at the higher concentration
tested. By The JPEG images were analyzed after setting the specific parameters (Hue adjustment
section of the Threshold Color window) described in detail in the Materials and Methods section
(Section 2). The assay reproducibility was evaluated for three identical test zones.
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Figure 3. Hue adjustment section of the Threshold Color window in ImageJ analysis software of the
NH3 PAD.

The functionalization of PAD for the detection of C2H4O was achieved by the use of methyl red.
The latter is determined by the concentration of acidic (red) and basic (yellow) forms. The colorimetric
sensor was designed to show a selective response based on a chemical reaction, such as the nucleophile
addition. Using an excess of hydroxide ions, the C2H4O underwent the nucleophile addition reaction,
resulting in the sensor alkalinity changes and consequently in a color change, from yellow to red.
The color change was almost instantaneous and it was stable for several days after drying. After the
color response, the scanner was used to acquire the image and color intensity. The latter was analyzed
for the second step of the experimental session using ImageJ analysis by the Hue adjustment section of
the Threshold Color (Figure 4). The reproducibility was evaluated for three identical test zones.



Sensors 2020, 20, 5502 9 of 16Sensors 2020, 20, x FOR PROOF 9 of 18 

 

 

Figure 4. Hue adjustment section of the Threshold Color window in ImageJ of C2H4O PAD. 

The test zones were used to create the calibration curve. Figure 5 shows the calibration curve for 

NH3 detection using the color change after the exposure to the four concentrations. In detail, in Figure 

5a we reported the pieces of devices related to the functionalized and unexposed PAD (top circle) 

and the PAD exposed to pure NH3 (28%, bottom circle) with the relative MGV values extracted from 

the ImageJ analysis that were 10.3 ± 1.5 and 75 ± 4.5, respectively. In Figure 5b, the pieces of PAD 

after exposure to 100, 300, 500 and 1000 ppm of NH3 were represented. Observing the pictures, it was 

possible to visualize a color trend with the naked eye, from the lightest to the darkest as the 

concentration increased. The successive ImageJ analysis performed on the scanner acquisitions 

correlated with the concentration with a specific MGV obtaining a calibration curve with R2 = 0.99. 

The limit of detection (LOD) value was 7.64 ppm. The values were obtained by repeating the 

experiment three times. In order to understand if the device actually worked even with intermediate 

concentrations, we exposed the PAD to average concentrations calculated between the first and 

second (200 ppm) and third and fourth doses (750 ppm). Additionally, in this case, PANI film was 

able to efficiently induce the color response; it was possible to find the concentration simply by 

interpolating the MGV data on the straight line as shown in Figure 5c. 

Figure 4. Hue adjustment section of the Threshold Color window in ImageJ of C2H4O PAD.

The test zones were used to create the calibration curve. Figure 5 shows the calibration curve
for NH3 detection using the color change after the exposure to the four concentrations. In detail,
in Figure 5a we reported the pieces of devices related to the functionalized and unexposed PAD (top
circle) and the PAD exposed to pure NH3 (28%, bottom circle) with the relative MGV values extracted
from the ImageJ analysis that were 10.3 ± 1.5 and 75 ± 4.5, respectively. In Figure 5b, the pieces of
PAD after exposure to 100, 300, 500 and 1000 ppm of NH3 were represented. Observing the pictures,
it was possible to visualize a color trend with the naked eye, from the lightest to the darkest as
the concentration increased. The successive ImageJ analysis performed on the scanner acquisitions
correlated with the concentration with a specific MGV obtaining a calibration curve with R2 = 0.99.
The limit of detection (LOD) value was 7.64 ppm. The values were obtained by repeating the experiment
three times. In order to understand if the device actually worked even with intermediate concentrations,
we exposed the PAD to average concentrations calculated between the first and second (200 ppm) and
third and fourth doses (750 ppm). Additionally, in this case, PANI film was able to efficiently induce
the color response; it was possible to find the concentration simply by interpolating the MGV data on
the straight line as shown in Figure 5c.

The same procedure was applied to the paper functionalized with methyl red, capable of detecting
the C2H4O vapor. (Figure 6). Figure 6a shows the as-prepared paper device (yellow) and after
exposure to pure C2H4O (≥99.5%, dark red) with the corresponding MGV values that were 20.3 ± 2.7
and 155 ± 7.5, respectively. In Figure 6b, the progression from yellow to red was observed when
the tested concentrations increased. We used 100, 300, 500 and 1000 ppm concentrations and we
built the calibration curve obtaining an R2 value of 0.98 (Figure 6c). The LOD value was 11.09 ppm.
The effectiveness of this colorimetric response was verified using two average concentrations: 200 and
750 ppm. Additionally, in this case, the MGV values were interpolated with the curve that exactly
corresponded to the tested concentrations.
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Figure 5. (a) Mean Gray Value (MGV) values of PAD as prepared and after the exposure to pure NH3

(28%). (b) color change after NH3 exposure. (c) Interpolation of NH3 intermediate values (200 and
750 ppm). Data reported were the average of three independent experiments ± SD. The difference
between the as-prepared paper and colored papers was considered statistically significant performing
a Student’s t-test with p < 0.05 (<0.05 *).
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Figure 6. (a) MGV values of PAD as-prepared and after the exposure to pure C2H4O (>99%). (b) color
change after C2H4O exposure. (c) Interpolation of C2H4O intermediate values (200 and 750 ppm).
Data reported were the average of three independent experiments ± SD. The difference between the
as-prepared paper and colored papers was considered statistically significant performing a Student’s
t-test with p < 0.05 (<0.05 *).
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After the analysis of gaseous molecules, we used the PAD to detect Cu2+ and Fe2+, which are
the most common metals released in the environment [1]. Then, we moved to the detection of these
metals in water at low concentrations. Firstly, we designed four circle spots using a wax pen in order
to achieve hydrophobic barriers without the use of wax printing, inkjet printing and screen-printing
technologies. Once the heat produced by the hot plate allowed the penetration of the wax into the
cellulose porous, the specific chemical analytes, K3[Fe(CN)6] for Fe2+ and KI for Cu2+, were deposited
in the spot’s center by drop-casting. The wax channels prevented the typical diffusion phenomenon of
the liquid substances deposited on the paper. Five microliters of FeCl2.4H2O and CuSO4.5H2O (25, 50,
100, 200 µg/mL) were used. Chelation (1) and redox (2) chemical reactions produced a blue and brown
color, respectively. The two reactions were the following:

(1) Fe2+ + Fe(CN)3−
6→ Fe3[Fe(CN)6]2;

(2) Cu2+ + 2I−→CuI2→ 2CuI2 = 2CuI + I2.
After color formation, we acquired the images by a digital scanner to perform ImageJ analysis

using the adjustment of Threshold Color both for Fe2+ (Figure 7) and Cu2+ (Figure 8). The analysis
was repeated in three identical test zones.
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As shown in Figure 9a, the color changed from light blue to dark blue, proportionally to the
Fe2+ concentration increase. The corresponding calibration curve was obtained plotting the MGV
values analyzed by ImageJ analysis after standards solution deposition, showing an R2 value of 0.98
(Figure 9b).
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Figure 9. (a) Color change of filter paper after exposure to Fe(II) at different concentrations. (b) The
yellow rhombuses represented the interpolation of Fe2+ intermediate concentrations (37 and 150 µg/mL).
Data reported were the average of three independent experiments ± SD. The difference between
as-prepared paper and colored papers was considered statistically significant performing a Student’s
t-test with p < 0.05 (<0.05 *).

A similar R2 value was reported for the Cu2+ calibration curve; in the latter case, the color
changed from light brown to dark brown (Figure 10a). As demonstrated for NH3 and C2H4O we
used two average concentrations between 25 and 50 µg/mL and between 100 and 200 µg/mL (37 and
150 µg/mL) to test the device reliability. The MGV values acquisitions revealed that the corresponding
concentrations were on the calibration curve thus confirming the effectiveness and stability of the PAD
(Figure 10b). The LOD for Fe2+ was 3.8 µg/mL and 3.2 µg/mL for Cu2+. For both metals, the values
were greatly below the maximum acceptable concentrations in drinking water stipulated by the World
Health Organization (WHO) [54].

The LOD values of each device are summarized in Table 1.

Table 1. LOD values of NH3, C2H4O, Fe2+ and Cu2+ PADs.

PADs Concentrations Range Limit of Detection (LOD)

NH3 100–1000 ppm 7.64 ppm

C2H4O 100–1000 ppm 11.08 ppm

Fe2+ 25–200 µg/mL 3.8 µg/mL

Cu2+ 25–200 µg/mL 3.2 µg/mL



Sensors 2020, 20, 5502 13 of 16
Sensors 2020, 20, x FOR PROOF 14 of 18 

 

 
Figure 10. (a) Color change of filter paper after exposure to Cu(II) at different concentrations. (b)The 
yellow rhombuses represented the interpolation of Cu2+ intermediate concentrations (37 and 150 
μg/mL). Data reported were the average of three independent experiments ± SD. The difference 
between as-prepared paper and colored papers was considered statistically significant performing a 
Student’s t-test with p < 0.05 (<0.05 *). 

The LOD values of each device are summarized in Table 1. 

Table 1. LOD values of NH3, C2H4O, Fe2+ and Cu2+ PADs. 

PADs Concentrations Range Limit of Detection (LOD) 
NH3 100–1000 ppm 7.64 ppm 

C2H4O 100–1000 ppm 11.08 ppm 
Fe2+ 25–200 μg/mL 3.8 μg/mL 
Cu2+ 25–200 μg/mL 3.2 μg/mL 

In order to test the selectivity of the different PADs used in this study, several metal and gaseous 
solutions at 100 μg/mL and 100 ppm, respectively, were used. No significant visual color change had 
been observed in all the tested cases. For gaseous molecules, the PAD was exposed to methylamine, 
ethylamine, triethylamine, benzene, toluene, ethyl benzene, formaldehyde and ethanol at 100 ppm 
for ca. 15 min. Any noticeable effects on filter paper were recorded. This suggested the high selectivity 
of PAD to the NH3 and C2H4O only (Figure 11a,b). Similar results were obtained analyzing the 
interferences of different metal ions after PAD exposure for 15 min. It was observed that 100 μg/mL 
of Na+, K+, Mg2+, Ca2+, Al3+, Mn2+, Fe3+, Co2+, Ni2+, Zn2+, Cd2+, and Pb2+ highlighted negligible 
colorimetric effects on the PAD due to the small affinity with the analytes deposited on filter paper 
(Figure 11c,d). 

Figure 10. (a) Color change of filter paper after exposure to Cu(II) at different concentrations.
(b) The yellow rhombuses represented the interpolation of Cu2+ intermediate concentrations (37 and
150 µg/mL). Data reported were the average of three independent experiments ± SD. The difference
between as-prepared paper and colored papers was considered statistically significant performing a
Student’s t-test with p < 0.05 (<0.05 *).

In order to test the selectivity of the different PADs used in this study, several metal and gaseous
solutions at 100 µg/mL and 100 ppm, respectively, were used. No significant visual color change had
been observed in all the tested cases. For gaseous molecules, the PAD was exposed to methylamine,
ethylamine, triethylamine, benzene, toluene, ethyl benzene, formaldehyde and ethanol at 100 ppm for ca.
15 min. Any noticeable effects on filter paper were recorded. This suggested the high selectivity of PAD to
the NH3 and C2H4O only (Figure 11a,b). Similar results were obtained analyzing the interferences of
different metal ions after PAD exposure for 15 min. It was observed that 100 µg/mL of Na+, K+, Mg2+,
Ca2+, Al3+, Mn2+, Fe3+, Co2+, Ni2+, Zn2+, Cd2+, and Pb2+ highlighted negligible colorimetric effects on
the PAD due to the small affinity with the analytes deposited on filter paper (Figure 11c,d).Sensors 2020, 20, x FOR PROOF 15 of 18 
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4. Conclusions

The use of paper as a platform for sensing devices offers considerable advantages in terms of
affordability and availability of functionalization processes; in fact, the hydrophilic nature of paper
makes it a suitable tool due to the fast adsorption of different chemical solutions through its porous
structure. Since only small volumes of reagents are needed to functionalize the paper device, it is very
inexpensive. In addition, this technology does not require qualified personnel to collect and analyze
the data. We developed an easy and versatile PAD that is able to measure different pollutant agents,
namely NH3, C2H4O, Fe2+ and Cu2+, in two different mediums, air and water. The device architecture
is a “proof of concept” of a new class of colorimetric sensors. In fact, it could be implemented in
several environmental detection technologies, such as drones or aquatic sensors as well as individual
protection devices or wearable technologies, by an electronic integration. In addition, the PAD can be
used by different citizens of particular geographic areas to map the possible contaminations, with the
aim to collect the global data and to build a database to monitor the pollution.
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